INTRODUCTION

ABOUT UNIVIEW THEATER

Uniview Theater is a computer graphics platform bringing information databases to life in a 3D environment much like an immersive computer game. Loaded with scientific content, Uniview Theater brings your audience to the science and makes your stories truly meaningful and engaging. While completely interactive, your new system is powered with technologies that make sure every presentation is smooth, intuitive and engaging to the audience.

As the fastest-growing platform in the industry in recent years, Uniview Theater has been developed in collaboration with industry innovators from museums, science centers and academia. Experiencing the size of the universe in the same context as familiar sites is an enthralling and immersive experience.

The standardized user interface – based on normal Windows® components – makes Uniview Theater an easy to use and accessible tool for both experts and beginners, minimizing your initial and ongoing training costs. The smooth, cinematic motion, paired with the immersive nature of Uniview Theater, brings quality to your interactive presentations and ensures a highly satisfying visitor experience. The advanced computer graphics engine makes your new system as visually spectacular as any modern computer game, capturing the attention and meeting the demands of your visitors.

The highly evolved interactivity in Uniview Theater lets you do live presentations and virtually travel anywhere, at any time, in the universe; giving you control of your own show and allowing you to interact with your audience. Uniview Theater can record live interactive sessions and save to sequences for later playback, providing a simple yet powerful production tool that can reduce costs by orders of magnitude and allow you to update your linear programming more frequently. Uniview Theater can produce pre-rendered output in most standard formats, allowing you to produce linear shows and mix live footage with music, narration and post production effects for high end shows that makes your facility stand out.

Uniview Theater visualizes science of vastly different scales – from Earth Science and regional GIS data to large scale structures and cosmology, increasing the usability of your display venue and multiplying your target groups. Uniview Theater scales to vastly different platforms; from Windows® PC laptops to cluster installations, allowing you to use the same tool for all your visualization needs and reuse your knowledge throughout operations. Uniview Theater allows remote collaboration and shared experiences between display venues, schools and field experts, giving you the tool to integrate with your local or global community.
American Museum of Natural History develops and maintains the Digital Universe database.

Open Geospatial Consortium develops and maintains the OGC WMS specification.

Google develops and maintains the KML specification.

Smithsonian Astrophysical Observatory develops and maintains the minor planet catalogue and the MPC format.

NASA NAIF develops and maintains the SPICE toolset and many kernels.

North American Aerospace Defence Command (NORAD) developed the Two-Line Element format.

Stuart Levy and NCSA develop and maintain Partiview and the SPECK format.

Denver Museum of Nature and Science and California Academy of Sciences have supported the development of Uniview Theater far beyond what can be expected from a committed user.

Carl Zeiss, Global Immersion and Elumenati have provided tools for geometry correction and continuous input from the community.

Windows is either a registered trademark or trademark of Microsoft Corporation.

Google and Google Earth are either registered trademarks or trademarks of Google.
# CONTENTS

About Uniview Theater ........................................................................................................... 2  
Acknowledgements .................................................................................................................. 3  
The Start Menu ......................................................................................................................... 5  
Profiles ................................................................................................................................... 6  
  How to Build a Profile ............................................................................................................. 6  
  How to Start with a Profile .................................................................................................... 6  
Using the Mouse to Control Uniview Theater ......................................................................... 7  
The Camera Menu .................................................................................................................... 8  
  Lock to Current Target ......................................................................................................... 8  
  Lock to Sun ............................................................................................................................ 8  
  Release Lock ......................................................................................................................... 8  
The Camera Modes .................................................................................................................. 9  
  Orbit Mode ............................................................................................................................ 9  
  Free Flight Mode ................................................................................................................ 10  
  Surface Mode ...................................................................................................................... 10  
  Friction ................................................................................................................................ 10  
  Transitions ........................................................................................................................... 11  
The User Interface Window ..................................................................................................... 12  
  The File Menu .................................................................................................................... 12  
  The Windows Menu ........................................................................................................... 13  
  The Bookmarks Menu ........................................................................................................ 14  
  The Status Bar .................................................................................................................... 14  
  The Main Tool Menu .......................................................................................................... 14  
The Camera Tool .................................................................................................................... 15  
  The Basic Controls .............................................................................................................. 15  
  Advanced Controls ............................................................................................................. 16  
The Time Tool ....................................................................................................................... 17  
  Basic controls ....................................................................................................................... 17  
  Toggle the Visibility of Objects ........................................................................................... 19  
  The Context Menu .............................................................................................................. 19  
The Properties Tool ................................................................................................................ 21  
  Point Objects Properties ..................................................................................................... 21  
  Geometrical Objects Properties .......................................................................................... 23  
  Massive Object Properties ................................................................................................. 24  
The Geoscope Tool ................................................................................................................ 26  
  Introduction to WMS Servers ............................................................................................. 26  
  Adding Layers ...................................................................................................................... 26  
  Modifying Layers ................................................................................................................. 27  
  Draw Order of Layers ......................................................................................................... 28  
  Adding Servers .................................................................................................................... 28  
  KML Files .............................................................................................................................. 30  
  The Geoscope Configuration File(s) ................................................................................... 30  
  Layer Sets ............................................................................................................................. 30  
Introduction to Networking ..................................................................................................... 31  
  Connecting to a Server ........................................................................................................ 32  
  Session Owner vs. Session Participants .............................................................................. 32  
  Controls During a Session .................................................................................................... 32  
  Voice Communication .......................................................................................................... 33  
  Firewalls and Ports .............................................................................................................. 33  
  Adding and Configuring Servers ......................................................................................... 33  
The Bookmarks Menu ............................................................................................................ 34  
  Bookmark Files .................................................................................................................... 34  
The Playlist Tool ..................................................................................................................... 35  
  Render to Frames ................................................................................................................. 36  
  Output Section ...................................................................................................................... 36  
  Channel Settings ................................................................................................................ 36  
The Command Console Tool .................................................................................................. 38  
Custom Events Tool ................................................................................................................. 39  
Configuration Files .................................................................................................................. 41  
  Unview/config/Unview.ini ................................................................................................... 41  
  Unview/config/Settings.ini ................................................................................................. 41  
  Unview/config/Text.conf ..................................................................................................... 41  
  Unview/config/freelookcam.conf ....................................................................................... 41  
  Unview/data/loaderscreen/loaderscreen.conf .................................................................. 41  
  Unview/data/menu/menu.mu ................................................................................................. 41  

4
STARTING UNIVIEW THEATER

This chapter describes how to start Uniview Theater on your system. While starting in default mode is only one double-click away, Uniview Theater also provides mechanisms for starting using various profiles and customized modes.

THE START MENU

To start Uniview Theater, double-click its icon in the Uniview folder of the controller computer, or use the start menu or desktop shortcut. This brings up the Launch Menu from which you can start Uniview Theater in default configuration or with a customized profile.

To start Uniview Theater in default configuration, press the Start (Default) button. When properly installed, this will launch Uniview Theater on all nodes across your system.
You can also expand the Advanced frame by clicking the plus icon next to the Advanced label. Here you find buttons for synchronizing data across the cluster (something you need to do after having added new data to your installation) and for configuring your cluster.

In the Advanced frame, you will also find a button for editing profiles as explained in the next chapter.

**PROFILES**

Uniview Theater release 1.3 supports a new feature called profiles. This is a system through which users can customize their data and property settings so that multiple users on the same system can use different data and have different settings.

**HOW TO BUILD A PROFILE**

To build a profile, click the plus icon to expand the Advanced frame in the launcher. Then click the button called Edit Profiles… to open the Profile Editor interface.

In the left frame of the Profile Editor, you see a list of all the available data modules in your installation of Uniview Theater. This list corresponds to all the folders available inside the Uniview/modules folder. In the upper right corner of the editor, there is a pull-down menu from which you can select what profile to edit, or to Create new Profile… The latter will open the Create Profile dialog, where you are asked to give a name to your profile. When you have given it a name and clicked Ok, the new profile is created.

To modify what data modules are loaded in a profile, use the check-boxes in the left hand frame. A checked box means that this data module is included in the profile and will be loaded when Uniview Theater is launched using that profile. When selecting a data module, a brief description is shown in the Description frame on the right hand side of the Profile Editor window. Descriptions are created by the respective authors of the modules, and may vary from nonexistent to very instructive and useful.

You must also select a Starting Location for your profile. This is the name of the data module you want Uniview Theater to focus on upon launch. Make sure to specify a starting location that corresponds to a selected data module, otherwise the behavior of Uniview Theater is undefined.

**HOW TO START WITH A PROFILE**

Instead of clicking the Start (Default) button, hover with the mouse cursor over that button so that you see box with a small arrow on the right hand side of the button. Clicking inside that box will bring up a pull-down menu that lets you choose from the existing profiles.

In addition to the data loaded, bookmarks, custom events and user-modified object properties are also unique to each profile. Any bookmarks, custom events or property settings you create during runtime will be saved and accessible to you again the next time you launch the system using the same profile.
BASIC NAVIGATION

This chapter describes the concepts of navigation in Uniview Theater. It gives an overview of the camera model and explains how to use the mouse to navigate through the virtual environment. Throughout this chapter, we will use the term Camera to refer to the viewpoint in space at any given time. Moving through the three-dimensional environment is consequently referred to as camera movement.

USING THE MOUSE TO CONTROL UNIVIEW THEATER

All navigation in Uniview Theater is done with the mouse. The input is based on relative movements of the mouse and only while certain buttons are pushed. This allows you to easily achieve smooth movements and eliminates the risk of the camera “flying away” should the mouse be moved by accident. The normal procedure is to press and hold a button of choice. As long as the mouse pointer is moved while a button is pressed, the camera accelerates. As soon as the button in question is released, the camera slows down and comes to a halt. This concept is called Friction and will be explained a little bit further down in this section.

The actual position on the screen at which you press a button the first time has no real impact on the resulting camera movement. Only the movement of the mouse after the button has been pressed affects the camera. The most common camera mode in Uniview Theater is called Orbit Mode. There are two other camera modes; Free Flight and Surface Mode.
The Camera Menu is a way to access camera specific options. It contains the most popular of the options available in the Camera Tool described in a later chapter. You can change between the three different camera modes: orbit, free flight and surface, as well as toggle rotational and translational friction. These commands are explained in detail in the Basic Navigation section below. You can also use this menu to trigger the most common camera lock modes; Lock to Current Target, Lock to Sun and Release Lock.

**LOCK TO CURRENT TARGET**

Locking to the current target will result in the camera following any rotation of the target object. So, if you for example target the Earth and select this option the camera will stay in a fixed position relative to Earth while the surrounding environment rotates. This mode is useful if you want to explore the surface of a planet or moon.

**LOCK TO SUN**

Locking to the Sun has the effect of the Sun staying in a fixed position on the screen. This mode can be helpful when explaining phenomena such as seasons or eclipses.

**RELEASE LOCK**

Another way of describing Release Lock would be Lock to Stars. Select this option to have the stars in fixed position on the screen whenever you stop moving.
THE CAMERA MODES

ORBIT MODE

This is the default and most commonly used camera mode in Uniview Theater. In this mode, the camera’s focus is locked directly at the center of the object of interest, the target, and moves in spherical orbits around it.

ROTATING

If you press and hold the left mouse button and drag the cursor in any direction, the camera will start rotating in an orbit around the target. The further you drag the cursor from the movement’s point of origin, the faster you will rotate. As soon as you release the left mouse button or drag the cursor back to the movement’s point of origin, the rotation will slow down and eventually come to a complete halt.

Even though there strictly speaking is no up or down in space, it is sometimes convenient to align the view if it seems to be upside down or slightly unaligned. By pressing and holding the middle mouse button and dragging the cursor to the left and right, it is possible to roll the view around the viewing direction.

MOVING

To change the distance to the target, press and hold the right mouse button and then dragging the cursor up in order to move closer and down to move further away. Uniview Theater automatically adjusts the velocity of the camera depending on the distance to its target. When you release the right mouse button, the camera will slow down and eventually come to a complete halt.

TILTING

Another way to use the orbit camera mode is very handy when observing the surfaces of planets at very low altitudes. If you rotate the camera while pressing and holding the CTRL button, the rotation will be similar to rotations during free flight mode. It will rotate around its own center. However, after you release the CTRL button, the camera will keep behaving like an orbit camera – but no longer be facing straight at the object. If you approach a planet, rotate 90 degrees around its own axis and then continue to orbit, the appearance will be similar to that of an aircraft flying over the surface of the planet.

LOCKING

While in Orbit Mode, it is possible to “lock” the camera to a secondary object. Locking to an object means that the locked object stays at a fixed location on the screen/dome. The difference between orbit with or without
locking enabled may not be noticeable if the target and the locked object barely move in relation to each other. Once you increase speed of time in Uniview Theater, the difference will however soon become obvious.

**FREE FLIGHT MODE**

Even though convenient in most scenarios, it may not always be desirable for the camera’s focus to be locked on a certain object. In orbit mode, it is for instance not straightforward to fly away from a certain position without looking back at it at the same time. For complete freedom of movement, the Free Flight Mode is the better choice. When this mode is activated, any previously held lock on any object (such as a planet in orbit mode), is released. From now on you may rotate any way you want and you may move to any position you want.

**ROTATING**

To rotate the camera, press and hold the left mouse button while dragging the mouse in any direction. Rolling is done just like in orbit mode by pressing the middle mouse button and dragging the cursor to the left or right. As usual, if a button is released, rotation will come to a halt.

**MOVING**

Right-clicking and dragging the cursor up or down will move the camera forwards or backwards. Release the right mouse button to stop.

**SURFACE MODE**

When very close to the surface of for example a planet and the orbit camera has been used to zoom in and tilt the camera to a nice view over the horizon, the Surface Mode adds even more to the feeling of flying an aircraft.

The Surface Mode camera behaves very similar to the Orbit Mode camera, but also has built-in functionality to perform banking when making turns.

**FRICTION**

Uniview Theater applies certain types of friction to its camera regardless of camera mode. The friction causes the camera to slow down gradually instead of immediately stopping its movement. It also prevents the camera from accidentally achieving too high velocities. You may change whether or not friction should be applied. An operator can set the camera into a slow rotation in orbit mode with rotational friction disabled. After this, the camera will keep rotating around the target, giving the viewers a good way to capture the three dimensional...
structure of what they are seeing. While in this mode, the operator can release the controls and focus on other things than controlling the camera.

**TRANSITIONS**

When you switch between camera modes or change target in orbit mode, the camera may need to move from one position to another. These movements are referred to as transitions. In many cases it is possible to get an automated transition where the camera enters an autopilot mode during which it moves from point A to point B. These offer a continuous ride through space. Once the destination is reached, the user will regain control over the camera. Should the user not wish to wait for the camera to fly to the destination on its own, it is also possibly to do a direct jump to the same point. During this jump the camera will fade to black and then fade back again.
OVERVIEW OF THE USER INTERFACE

This chapter describes the main window of Uniview Theater and the graphical user interface (GUI). Apart from navigation, all aspects of Uniview Theater are controlled from the GUI.

Figure 1: The Uniview Theater GUI

THE USER INTERFACE WINDOW

At the top of the Uniview Theater window, a number of pull-down menus are accessible through the menu bar. The important ones are, in addition to the Camera menu that we have already explored in the Basic Navigation chapter: File, Windows and Bookmarks.

For menu items that are used frequently, you may find hints to keyboard shortcuts that will trigger the same functionality.

THE FILE MENU

The file menu contains two alternatives: Settings, Make Screen Shot... and Exit. Choosing the Settings option will bring up a window that where you can make certain changes to the way that Uniview Theater behaves. Changes you make are saved permanently if you press Save. Cancel will discard any changes.
The Settings Dialog consists of two sections; Labels and Input. For labels, you can choose to check or uncheck the World Space Labels check box. If checked, the size of object labels will depend on their distance to the viewer. You can also choose to check or uncheck the Rotate 180 Degrees check box. This option allows you to flip the labels 180 degrees. This is useful in certain dome configurations. Clamping of label size means that when world space labels are enabled, the clamping values will determine the minimum and maximum sizes of the labels. The size slider allows you to change the size of all labels in Uniview Theater at the same time. And finally, the singularity direction is best explained as the direction which is to be considered pointing "up" on the display. On a single-screen computer display, the singularity should be set to Heading: 0, Pitch: 270, Roll: 0. In a dome, the singularity can be set to an suitable value, depending on the dome environment.

In the Mouse section, use the two check boxes to flip the input of the mouse in case you feel that the default input scheme is unnatural to you. The sensitivity of the mouse can be adjusted with the Sensitivity slider. Higher values mean that less mouse movement is required when navigating.

THE WINDOWS MENU

The Windows menu allows you to customize the user interface. By triggering the Full Screen menu item (or by pressing F11 on the keyboard), Uniview Theater is set to full screen mode. Doing so will remove the borders of the main Uniview Theater window as well as the menu at the top of the screen. Pressing F11 again will bring you back to default windowed mode.

The Windows menu also lists all the tool windows in Uniview Theater. These help you control various aspects of the system. The tool windows are small, floating windows which can be moved to any location on the screen. You can enable or disable individual tool windows from the Windows menu. The most important tool windows can also be directly accessed through the Main Toolbar where they are represented as small icons.

By selecting the Hide Tools option (or pressing F9 on the keyboard) you will hide all tool windows. Pressing F9 again will bring the tool windows back. By selecting the Reset Tools to Default Layout option (or pressing Alt-R on the keyboard) you restore all tools in the graphical user interface to their default position and visibility states. Finally, by using the Save Current
You can save your current layout so the graphical user interface looks the same the next time you start Uniview Theater.

THE BOOKMARKS MENU

The Bookmarks menu controls bookmarks, specific locations in space and in time that you can save and later jump or fly back to. Bookmarks provide a powerful way of smoothly navigating in Uniview Theater and are explained further in the Advanced Navigation section.

THE STATUS BAR

The Status Bar is located along the bottom of the main window. The slider control to the right lets you change the field-of-view of the rendering viewport. In a cluster environment, this action will only affect the control machine. The status bar also shows your current travel velocity and distance to target.

THE MAIN TOOL MENU

The Main Toolbar lets you show/hide the most common tool windows in Uniview Theater. The buttons represent (from left to right):

- Object Tree
- Object Properties
- Geoscope
- Camera
- Time
- Custom Events
- Playlist Control
- Command Console
- Octopus
CAMERA PROPERTIES

This chapter teaches you how to control the finer aspects of the camera in Uniview Theater. The Camera tool is enabled through the Windows->Tools->Camera menu, or by clicking its button in the Main Toolbar.

THE CAMERA TOOL

Many aspects of the camera modes described above can be controlled through the mouse and the camera pull-down menu. In some cases however, the camera menu is an easier way of accessing all of the specific options available for the camera. To launch the camera tool, click the camera icon in the main Uniview Theater toolbar.

THE BASIC CONTROLS

The Camera Mode pull-down menu contains the available camera modes. Possible choices are orbital, free-flight and surface mode, with orbit mode being the default. The Target (Lock) section shows the currently selected target object. If you have chosen to lock towards a secondary object, it will be shown within the brackets.

The Friction section has four options. You may choose to disable rotational and/or translational friction, as well as toggle full friction for any of them. Full friction will cause the camera to immediately halt once you let go of the mouse button.

ADJUST ANGLE (ORBIT MODE ONLY)

Pressing this button will change the input scheme. Instead of rotating around the target object, all rotations will now be around the camera. This option lets you tilt, or offset the view without actually moving. This is useful, for example, if you fly up close to a planet and want to raise the viewpoint to look towards the horizon instead of straight down. Press this button again to return to normal operation. You can also perform this operation by keeping the CTRL key pressed on the keyboard while rotating the camera. Release the CTRL key to return to normal navigation.
Use the Speed slider to change the camera speed. When aiming towards a secondary object, you may specify an offset angle to avoid having the aim object end up directly behind the target object. This is done through the Aim Offset input dialog. The Release Lock button is used to release any camera lock and return back to normal orbit mode (i.e. locked to the stars).

The two input dialogs for latitude and longitude provide a mechanism to specify a certain location on the planet you wish to move to. Clicking the set button will initiate a smooth transition to the desired location. Note that altitude is not affected by this action.
SIMULATED TIME

This chapter will describe how to control time. Uniview Theater is a running simulation, where planets, moons and other objects travel through space as time passes. In this chapter, you will learn how to adjust the simulated time in Uniview. The Time Control tool is enabled through the Windows->Tools->Time Control menu, or by clicking its button in the Main Toolbar.

THE TIME TOOL

Use this tool window to set the simulated or “virtual” time in the Uniview Theater environment. All the planets, moons and satellites are affected by this time.

BASIC CONTROLS

The Date and Time (GMT) field shows the current simulation time. You can use the Set to Current Time button to set the simulation to the current date and time. You can also change the Date and Time fields and press Set (Local) to instantly go to a new simulation time.

Simulation speed in Uniview Theater is expressed in how fast the simulation runs compared to real-world time. Two simulation seconds per real-time second means that the simulation runs twice as fast as the real world. Click on the up/down arrows next to the left text field to adjust the simulation speed. You may also type a number directly into the text field and press ENTER. The pull-down menu on the right contains units, such as seconds, minutes and days. So, for example, typing the value “2” into the text field and selecting the unit “Minutes” means that the simulation will run at a rate of two minutes per second.

If you want to temporarily speed up the simulation time, use the shuttle speed slider. The further to the right you drag the slider, the faster time will pass. If you drag the slider left, time will go backwards. When you release the slider, the simulation time will slow down to the preset rate again. Adjust the speed by dragging the
slider and press the “t” key on the keyboard and the simulation speed will continue to run at the rate specified by the slider.

Press the Reverse button to make the simulation time run backwards. Pressing it again will switch back to “forward time”. When you press the Real-time button, the simulation speed will be set to one simulation second per real-time second and when you press Stop the simulation time will freeze. Use the Go Back / Skip Ahead buttons to make the simulation time take one step, at the length set by the simulation speed control, back or forth.
THE OBJECT TREE

It is possible to load a large amount of data into Uniview Theater. This chapter introduces the Object Tree – a multipurpose tool which lets you browse all objects, change their visibility, and trigger automatic camera transitions. The Object Tree is enabled through the Windows-Tools-Object Tree menu, or by clicking its button in the Main Toolbar.

THE OBJECT TREE TOOL

The Object Tree is probably the tool you will use most frequently. It gives you access to all objects and lets you perform various operations, such as toggling their visibility and triggering camera transitions.

The Object Tree is sorted into groups in order to help you find objects quickly. Each of these groups contains additional sub groups or categories. Clicking on the plus symbol (+) next to a group will expand the group and show its contents.

TOGGLE THE VISIBILITY OF OBJECTS

Each item in the object tree has a checkbox next to it. This checkbox represent the visibility of the object. When you first start Uniview Theater, you will notice that some boxes are checked and others are not. This is the
default configuration but you may change this to better suit your needs. Clearing a checkbox will hide the object in question while marking a checkbox will reveal the object. You may also show or hide an entire group of objects by pressing the SHIFT key when clicking on a group checkbox. Let’s say you want to hide all solar system objects. Simply press SHIFT and clear the Solar System checkbox and all planets and moons will disappear.

THE CONTEXT MENU

Right-clicking on any item in the object tree will bring up the Context Menu. Apart from toggling visibility with the checkboxes, all of the object tree functionality is accessed from this menu. The options available in the context menu are:

- Set As Target
- Fly To
- Jump To
- Lock
- Lock And Aim
- Sort Children
- Properties...
- Geoscope Layers...

Please note that certain items in the object tree may display only a subset of the above.

SET AS TARGET will rotate the camera towards the object. Once the rotation has finished, the camera will be in orbit mode around the new object.

FLY TO will launch an automated flight to the object that you have right-clicked. When the destination has been reached, the camera will be in orbit mode around the new object.

JUMP TO is similar to FLY TO except that it triggers a “jump” to the object. When the “jump” has finished, the camera will be in orbit mode around the new object.

LOCK effectively changes the frame of reference for the camera. Locking to an object will make that object stay in a fixed location on the dome/screen as long as no manual camera movement is performed. This option does not change the current target object.

LOCK AND AIM does the same as the Lock command described above, but also triggers a transition whereby the camera rotates to look at the locked object.

SORT CHILDREN This option will sort all items alphabetically within the right-clicked group.

PROPERTIES… will display the properties of the right-clicked object in the Properties Tool Window. Should the Properties Tool Window already be open, you just need to select an object (i.e. left-click) in the object tree to show its properties.

GEOSCOPE LAYERS… will bring up the Geoscope menu for the object chosen, if the object has capabilities to use Geoscope layers.
OBJECT PROPERTIES

This chapter explains how to change the appearance and behavior of the various objects in Uniview Theater. The Properties tool is enabled through the Windows->Tools->Properties menu, or by clicking its button in the Main Toolbar.

THE PROPERTIES TOOL

The layout of the Properties Tool depends on which object you have selected in the Object Tree. Uniview Theater supports several different object types and each of those has their own layout.

POINT OBJECTS PROPERTIES

Point Objects refer to all data sets made up by collections of points. Stars, galaxies and many astronomical surveys are expressed as point objects. This data format was originally developed for the Partiview software and as such it has a few additional capabilities including representation of very simplistic geometries.

GENERAL SETTINGS

The visibility setting controls the visibility of the object (or data set). The visibility can be set to On, Off or Auto. While the On and Off states are easy to understand, Auto requires further explanation:
Displaying too much data at the same time may be confusing to the audience. The Auto state helps you manage the visibility of data sets by automatically showing and/or hiding them depending on the context.

For example, when flying through the solar system, the galaxies and other remote objects are hidden, as they would otherwise clutter the night sky. As you leave the Milky Way, those objects will automatically start to appear. Even if this is helpful in many situations, you may want to override this behavior. Do this by changing the visibility setting from Auto to On or Off.

The label setting lets you set the visibility of labels for the object (or data set).

The Color Picker lets you change the color of the object or data set. Please note, however, that certain point objects use their own custom color map. Changing the color for such objects won’t have any effect.

Most point objects are rendered using both points and polygons. Use the Render Points and Render Polys checkboxes to change the rendering method.

THE PROPERTY SLIDER

The Property Slider lets you change many additional properties of the point objects. Select a property in the pull-down menu and drag the slider to change its value. Alternatively, you may type a new value directly into the box next to the pull-down menu.

Available properties are:

- Slum
- Alpha
- Polysize
- Ptsize [min]
- Ptsize [max]
- Polysides
- Psize
- Lsize
- Polymin
- Polymax
- Meshsize
- Labeltargetradius

SLUM is a brightness multiplier to the object.

ALPHA is the transparency of the object, where 0 represents fully transparent and 1 represents fully opaque.

POLYSIZE is a value controlling the size of polygons. Most objects are represented using both a point and a polygon and this variable can be used to control the balance of the two elements in the visual representation.

PTSZE [MIN] is the threshold under which points will not become any smaller. This value can be used to control the point appearance of very distant objects.

PTSZE [MAX] is the threshold over which points will not become any larger. This value can be used to control the point appearance of very nearby objects. Note that in addition to this variable the graphics hardware will impose an upper limit to the point size.
POLYSIDES represents the number of sides of polygon representations. Most commonly used to differ between different datasets without texture maps.

PSIZE is a value controlling the size of points. Most objects are represented using both a point and a polygon and this variable can be used to control the balance of the two elements in the visual representation.

LSIZE is a value controlling the size of the label for an object.

POLYMIN is the threshold under which polygons will not become any smaller. This value can be used to control the polygon appearance of very distant objects.

POLYMAX is the threshold over which polygons will not become any larger. This value can be used to control the polygon appearance of very nearby objects.

MESHSIZE is a value controlling the line width of wireframe meshes.

LABELTARGETRADIUS is a value controlling the distance from a point in a dataset where the camera will stop upon automatic transitions (i.e. fly-to).

**GEOMETRICAL OBJECTS PROPERTIES**

The Properties Tool for geometrical objects (planets, moons and satellites that have a more detailed representation than a point or a flat polygon) contains three different sections which you can switch between by clicking on the tabs at the top of the window. The sections are Appearance, Trajectory, and Marker.

**THE APPEARANCE TAB**

The Appearance Tab lets you change the visual appearance of the orbiting object. Use the Visibility settings to control the visibility of the object and the label setting to set the visibility of the label for an object.

If you want to rescale an object, type in the desired scale in the Scale dialog, the desired duration of the animation changing the scale in the Duration dialog and press Set. The object will smoothly rescale itself to the new scale in the amount of time specified as duration.

**THE TRAJECTORY TAB**

The Trajectory Tab lets you change the visual appearance of trajectory representations, which means the trace of movement behind any moving geometrical object (such as planets and moons in orbit). Use the Visibility settings to control the visibility of the trajectory representation. You can choose the appearance of the trajectory by using the Type menu. Available modes are Line, Points, Simple Line and Simple Points.

Use the Color Picker to change the color of the trajectory and set the opacity value to affects how transparent the trajectory should be. 100% opacity equals no transparency – 0% opacity equals full transparency (i.e. the trajectory won’t be visible). Change the width value to make the trajectory line thicker or thinner.

**RELATIVE OR ABSOLUTE ORBITS**

Relative rendering means that the length of the trajectory will be relative to one full period. If you select Absolute, you will be able to explicitly define the length of the trajectory in terms of duration of time. The Fade
value specifies how soon the trajectory should begin to fade out. Set this value to 0% if you want a completely solid orbit. This value specifies the actual length of the trajectory. In **Relative** mode, it is specified as a percentage of a full period. In **Absolute** mode, this field lets you specify the duration of the trajectory.

---

### THE MARKER TAB

The **Marker Tab** lets you add various grids and markers to an object. These can be helpful teaching aids when explaining astronomy and the solar system.

Create a new marker by pressing the **New** button. This will bring up a context menu where you can choose which of the 13 available marker types you want to create. The available types are:

- Altitude / Azimuth Grid
- Cardinal Points
- Cartesian Grid
- Coordinate System
- Equator
- Latitude Line
- Local Meridian
- Location Marker
- Longitude Line
- Long/Lat Grid
- Meridian
- Pole Lines
- Radial Grid

Select a type and the tab will change its appearance and let you set the color of the marker using the color picker, specify the opacity value of the marker, line width and label rendering. You can also choose to project certain markers to infinity instead of being placed on the object. This is very useful for comparing markers on two different objects. Mark this checkbox to enable projection.

---

### MISC SETTINGS

The misc settings vary for different markers. Some have a spacing value, which specifies the resolution of grids. This value is a multiplier of the object radius. When available, use any combination of the axis check boxes to enable grids along these planes. Other settings should be self explanatory.

---

### ADDING OR REMOVING MARKERS

When you have created a marker, click the **Ok** button to add it to the geometrical object. This takes you back to the original look of the **Markers Tab**. Now you can select any marker and click **Edit** to change its settings, click **clear** to remove all markers or **New** to create more markers. You can also save your markers to disk by clicking the **Save** button, so they will be available the next time you launch Uniview Theater using the same profile.

---

### MASSIVE OBJECT PROPERTIES

In Uniview Theater, a **Massive Object** refers to an object type which consists of a large number of small objects in orbit. An example of a **Massive Object** is the GPS satellites hovering above Earth. All these satellites are treated as one single object, which means that by editing the properties for a **Massive Object**, you simultaneously change the attributes for all objects within that specific data set.
The Visibility setting lets you choose whether the objects should be visible or not. Use the Labels checkbox to display label names (when available) for the individual objects.

Use the color picker to set the color of the object representations. Each set of massive objects can have two colors, one for their orbit lines and one for the point representing the actual body at any given point in time. The alpha value lets you adjust the transparency of the object representations.

Many data sets consist of so many objects that it may degrade performance if all are rendered at once. Adjusting this value will increase or reduce the number of objects being rendered. A value of 1.0 will render all objects and a value of 0.0 will render nothing.

The pull-down menu at the bottom of the window lets you select the render method for the trajectories. Available options are None, Trails and Solid. Trails are left behind moving massive object bodies so that their position over the last few hundred frames is tracked. The faster a body moves, the longer its trail.
GEOSCOPE

This chapter describes the new Geoscope toolset, turning Uniview Theater into an online 3D browser for satellite imagery.

THE GEOSCOPE TOOL

Geoscope is a new feature in Uniview Theater that allows you to bring in data from online sources including WMS servers and KML files.

INTRODUCTION TO WMS SERVERS

WMS servers are repositories of imagery that can be downloaded directly into Uniview Theater. WMS is a common standard developed by the Open Geospatial Consortium. Existing WMS servers publish data available for Geoscope in a format that we will refer to as a layer. Think of a layer as a map, either a global or a local map with an often very high resolution.

ADDING LAYERS

To launch the user interface for the Geoscope feature set, click the globe icon in the main menu of Uniview Theater. This will bring up the Geoscope Tool. This tool operates on and affects the appearance of spherical bodies, such as planets, in Uniview Theater. The default body to affect is the Earth, but you can apply Geoscope features to certain other planets and moons too by clicking on their names in the Object Tree. When selecting a
body with support for Geoscope features, you will see that the title of the Geoscope Tool will change to the name of that body.

To add a layer to the Earth or to another planet you have selected, click the plus icon or select Add Layer... from the Layer menu. Both these operations bring up the Add/Edit menu.

First, let’s take a look in the Server Browser pull-down menu. Expand the menu to see what servers Geoscope is currently aware of. Selecting one of them will give you a list of all available layers from that server. Layers are typically organized in a hierarchy on the server, but how this hierarchy is arranged is entirely up to the server provider. You can browse the hierarchy of the server you have chosen by clicking the plus and minus signs in the server hierarchy frame until you reach any single layer. It is these bottom-level layers that contain the actual data.

When you click a layer from the hierarchy, a short description of the layer is shown in the Layer Description frame in the bottom of the window. This text is also provided by the server and some servers provide very detailed and useful information while other servers don’t provide any information at all. To add a selected layer, click the Add button in the lower right corner of the window.

Once you have clicked add, the Add/Edit menu disappears and you are back to the main Geoscope Tool again. Only this time, the white frame making up the major part of the menu is not empty but contains the name of the layer you have just added.

**MODIFYING LAYERS**

Through the main interface menu, you can perform simple operations on layers. Using the check boxes next to them to show or hide individual layers. You can also select a layer and use the Opacity slider to make the layer more or less transparent. Notice that using this slider will affect the entire layer. In many cases there are both opaque and transparent portions of a layer. To display that properly, don’t use this slider but rather the Use Transparency check box as described below. It is also possible to remove a layer from Geoscope by selecting it and clicking the minus icon or selecting Remove Selected Layer... from the Layer menu. Another sometimes useful feature when working with layers that are not global is the Crosshair button that automatically refocuses the camera to hover above the area of the selected layer.

More advanced properties of a layer are accessible from the Add/Edit menu. You can either modify advanced properties directly when you add a layer, or later by double-clicking the layer in the main user interface or select Edit Selected Layer... from the Layer menu.
Double-clicking a layer brings up the Add/Edit menu again. In this menu, there is a button called Show Layer Properties >>. Clicking this button expands the view to reveal the advanced properties.

The Follow Terrain checkbox is used to indicate whether you want Geoscope to generate new geometry for a layer or paste the layer textures onto the existing geometry for a planet. In most cases, it is not useful to generate new geometry so keep this box checked for most part.

Use Transparency is a useful checkbox. Most WMS servers can deliver their layers either with or without transparency information. If a layer contains data that highlights or emphasizes certain locations only, it is likely that there are fully transparent portions of the layer. As an example, think of a layer showing global political boundaries. Whereas the boundaries themselves are global, the actual landmasses are transparent. Unfortunately there is no standardized way to ask a WMS server if a layer contains transparent parts or not, so Geoscope asks you to use this check box to indicate the presence of transparency information in a layer.

Specify Date lets you request not only a layer, but the content of that layer at a given date. Many servers don’t change their layers’ content over time, but some do and in some cases it is important to be able to request a specific date. As an example, think of a layer showing forest fires globally. It is likely that you are not interested in the forest fires as they are today, but as they were on a specific date. Use this check box and the accompanying calendar tool to indicate what date you are interested in.

**DRAW ORDER OF LAYERS**

If you have added multiple WMS layers to a body, they are drawn on top of each other according to the order in which they are listed in the Geoscope main user interface window. This means if you have two fully opaque global layers, only the top one will be visible.

You can change the drawing order by grabbing a layer in the user interface and dragging it to the top of the list. Pay attention to the drawing order, and particularly to the fact that transparent layers will reveal underlying ones.

**ADDING SERVERS**

While Geoscope ships with connections to a number of default servers, you can dramatically improve the capabilities of Geoscope by adding new servers. To do this, click the plus icon or Add New Layer... in the Layer menu of the main user interface window again to bring up the Add/Edit window. Instead of selecting an existing server in the Server Browser select the Add New Server... option at the bottom of the pull-down menu.

This will bring up the Server Connection dialog. The WMS standard defines an interface for clients like Geoscope in Unview Theater to try to connect to servers. This standard is called a GetCapabilities request, and is basically a web address. GetCapabilities web addresses can be typed into the address field of a web browser,
and the corresponding site will show up as an XML file, i.e. a Capabilities Response. When you type in a GetCapabilities web address in the Server Connection dialog of Geoscope, the exact same thing happens except Uniview Theater and Geoscope saves you from having to view the XML file. Instead of opening the address in a browser, Geoscope opens it internally, downloads the Capabilities Response and interprets it to see if it is a valid server and if so what layers it contains.

A GetCapabilities request or web address has a very specific structure. First comes the address to the WMS server. After that follows parameters that are passed along to the server, so that it will know exactly what Geoscope is asking for. Let’s look at a typical GetCapabilities address:

http://neowms.sci.gsfc.nasa.gov/wms/wms?version=1.3.0&service=WMS&request=GetCapabilities

The first part, “http://neowms.sci.gsfc.nasa.gov/wms/wms”, is the address of the server. Then follows a question mark, which indicates that hereafter we are specifying parameters. Each parameter is separated from the previous by an ampersand (“&”).

The example above contains three parameters. First “version” specifies that we want to communicate with the server using the WMS specification version 1.3.0. Second “service” specifies that we are actually interested in WMS data and no other data, the same servers can often feed other types of data too. And finally, “request” says that we are asking the server for its capabilities and not for something else. Internally, Geoscope will later do similar requests to the server but with parameters like GetMap instead of GetCapabilities.

If this sounds very complicated, don’t worry. Most WMS server providers provide the GetCapabilities web address on their normal web sites. And if you have a UCare support subscription, you can find many new server GetCapabilities addresses on the Uniview Member Zone.

Once you have specified a GetCapabilities request in the Server Connection dialog, you can also chose to name the server. This is your internal name for the server and has nothing to do with what its official name is or what the provider calls it. If you want to refer to the Nasa Earth Observatory server in the example above as “Fancy stuff from NASA”, that’s fine. You can always edit this name later.

Once you have filled in the Server Connection dialog, click the Save button and Geoscope will try to connect to the server. If you have made a mistake in the GetCapabilities, or if the server is down, you will get an error message.
If you have edited the name or the GetCapabilities address of a server already in the list, you can click the Reload button instead of the Save button.

**KML FILES**

Uniview Theater also supports the Keyhole Markup Language (KML) file format, developed by Google™ for their Google Earth™ application. While WMS servers are used to stream raster images, i.e. satellite photography or similar, KML is used primarily for highlighting one or more locations on the surface of a body and for vector overlays.

Geoscope is used to load KML files into Uniview Theater. First, browse the internet to find the KML files you are interested in. If you have a UCare support subscription, make sure to check in to the Uniview Member Zone for discussions on interesting KML files. If you deploy all your internet search skills to find the most interesting KML files be cautious so you do not violate any copyrights or terms of use as there are literally hundreds of thousands of KML files out there with a wide variety of terms of usage.

Once you have found a KML file that you wish to display in Uniview Theater, you need to copy that file into the folder Uniview/data/KML of your Uniview Theater installation. If you are running on a PC cluster, you also need to synchronize your system before the KML files will work. Once properly copied and synchronized, you can access KML files in the same way as layers, but by selecting the server called Locally Stored KML Files in the Server Browser of the Add/Edit menu.

Caveat: Note that KML is customized for Google Earth™, and Uniview Theater does not support all of its features. Always try KML files during off hours before attempting to show them to an audience. Also, some KML files may take a long time to load in Uniview Theater. During this load time, Uniview Theater will be unresponsive and may appear to have frozen.

**THE GEOSCOPE CONFIGURATION FILE(S)**

The file Uniview/config/Geoscope.ini is the configuration file for Geoscope. In this file, you find a list of all the servers that Geoscope is aware of at any given point in time. Editing this file manually has the same effect as adding new servers through the Geoscope user interface.

Layer sets are also stored as configuration files. Users are free to save layers sets anywhere inside the Uniview folder of the installation.

**LAYER SETS**

Groups of layers can be saved for later use. To save a group of layers you have added to Geoscope, use the Layer Set menu. The same menu is used to load groups of layers from previous sessions.
OCTOPUS

Octopus is a new feature in Uniview Theater that allows you to connect with other users and share presentations across your venue and others’. This chapter describes Octopus.

INTRODUCTION TO NETWORKING

The concept of sharing experiences online is by no means new. Virtual worlds have been around for many years now, most commonly used in video games but also for other types of social networks. Uniview Theater is a science exploration tool and as such our version of a virtual world is slightly different. Instead of representing avatars of different users in the virtual world, we allow users to “piggy-back” on presentations made by others.

Octopus is a new feature that allows you to remotely bring in a scientist or presenter from another site using Uniview Theater and have him or her give a presentation to your audience. Or maybe you are that scientist, now able to give remote presentations to other Uniview Theater audiences around the planet.
CONNECTING TO A SERVER

An Octopus session is a limited period of time during which one or more users at the same time are connected to one and the same Octopus server, and see each others’ Uniview Theater navigation. A session is always hosted by an Octopus server. These are machines hosted by Sciss that run special server software and that your installation of Uniview Theater can connect to. To launch the Octopus user interface, click the broadcast icon in the main menu of Uniview Theater. This will bring up the main Octopus user interface where you connect to servers.

Start by looking in the Server pull-down menu. This is a list of the Octopus servers your installation of Uniview Theater is currently aware of. Select a server you wish to connect to and click the Connect button to attempt a connection. If your network is configured to accept the type of traffic Octopus uses, you should now be connected to the server.

Note that all your Geoscope layers will be cleared when you connect to an Octopus server. This is for synchronization issues, and users are advised to save a Geoscope layer set and reload it after connecting to Octopus.

SESSION OWNER VS. SESSION PARTICIPANTS

The first person to connect to a server at any given time immediately starts a session and becomes the owner of that session. Users who log on to the same server after the first user has logged on become session participants.

If the session owner disconnects from the server all other session participants are also automatically disconnected.

Only users who are registered as accepted session owners by the server can host sessions.

CONTROLS DURING A SESSION

When you are connected to an Octopus server, the user interface changes slightly and gives you three new buttons in the top of the window.

CLEAR HISTORY will clear all chat history.

REQUEST CONTROL will send a message to the current host of the session (the first person to log on to an unused Octopus server) asking him or her to hand over control to you.
DISCONNECT will terminate your current connection to a server.

During a session, the Chat window will display not only chat messages but also information on any additional users joining or leaving the session.

**VOICE COMMUNICATION**

While Octopus supports text chats, it does not currently support voice communication. We recommend using Skype conference calls for voice communication.

**FIREWALLS AND PORTS**

Octopus is sensitive to firewall restrictions. Your systems firewall should allow for outgoing traffic on the port intervals 21000-21100 and 22000-22100. This traffic is UDP only and used for establishing the connection between your system and the server. Octopus will then try to automatically locate an open port for the returning traffic once the connection is established.

On some networks with very strict firewall rules, you may need to specifically open the port for returning and ongoing traffic. Geoscope lets you specify this return port in the Octopus GUI, so this can be any port you like. Again, this traffic is UDP only.

**ADDING AND CONFIGURING SERVERS**

To connect to a new Octopus server, you need to know its IP number or domain name. Note that all servers are hosted by Sciss; it is not possible to distribute the hosting of servers to individual users.

If Sciss provides you with a new IP or domain name for a new server however, you can add that to the list of available servers by selecting Add New Server... from the server pull down menu. This will open the Octopus Server Connection dialog. The address field is the IP or domain name provided by Sciss, the port field is also provided by Sciss. If you have limitations to your internet firewall however, you can specify the return port which means traffic following after the connection attempt will happen over the specified port instead over an automatically selected port. See section Ports and Firewalls above.

Once you have specified IP or domain name and port settings, click Save to store the new server in the pull down menu. Clicking Save does not automatically try to connect to, or verify existence of, the server you have specified.
ADVANCED NAVIGATION

This chapter describes the Bookmarks feature.

THE BOOKMARKS MENU

Uniview Theater has a menu called Bookmarks. This is found in the main window pull-down menu. A bookmark is a specific location in space, and optionally time, that you can save and later jump or fly back to.

Create new bookmarks by selecting Add Bookmark... from the Bookmarks menu, or by using the CTRL-D keyboard shortcut. This will open the Add Bookmark dialog and ask you to give the bookmark a name. The Add Bookmark dialog also has a checkbox which says “Save current simulation time in bookmark”. This checkbox lets you control whether the simulation time should be saved with the bookmark or not.

All bookmarks that you create are available for later use to you through the Bookmark menu, and you can choose to fly or jump to a bookmark. Now, if you choose to fly to a bookmark that includes simulation time, you will trigger not only a camera transition, but also a time transition. You will see planets move along their orbits, rotate along their axis and so forth when flying to a bookmark with a distant timestamp. It is worth noting that while time transitions can be very effective and spectacular, they can behave less smooth when covering a large span of time.

Choosing NOT to include simulation time in the bookmark may produce a slightly different visual presentation when returning to the bookmark, depending on if there are time-dependant (moving) objects present at the bookmark location. This is because when you go to this type of bookmark, whatever simulation time you currently are using will be kept when arriving at the bookmark location, thus it may not be the same simulation time as when you created the bookmark. The advantage of taking this approach, however, is that you will be able to fly to the bookmark without visual artifacts, because no time transition will occur.

BOOKMARK FILES

If you have created a set of bookmarks that you want to share with other Uniview Theater users, you can find the files corresponding to your bookmarks in the Uniview/profiles/<profile-name>/bookmarks folder.
PLAYBACK OF PRE-RECORDED CONTENT

This chapter introduces the Playlist tool. This tool lets you view pre-recorded flightpaths and record your own sessions for later viewing. The Timeline Player is enabled through the Windows->Playlist Control tool, or by clicking its icon in the Main Toolbar.

THE PLAYLIST TOOL

The Playlist Tool lets you load and play pre-created flightpaths. It also allows you to record what you’re doing for later playback.

Press load button to load an existing flightpath or other Playlist element into Uniview Theater. The flightpath will appear in the playlist of the timeline player. Playlist elements can be sequences recorded using the Playlist tool (see below), bookmark files or WFX files exported from an authoring program such as Maya™ (contact Sciss support for a specification of the WFX file format). You can also remove Playlist elements from the list, rearrange them by dragging and dropping to make them play in the desired order, and stop and pause playback at any point in time. The load, save and clear functionality is also accessible from the Playlist pull-down menu at the top of the Playlist tool.

To record live sessions into a Playlist element (a sequence) press the red Record button. Uniview Theater will start recording everything you’re doing. Press the Record button again to stop recording. At this point, you will be asked if you want to save the recording to disk. You will also be able to preview the recording before saving it.
Once a sequence or flight path is loaded into the Playlist Control tool and highlighted by clicking it in the list of Playlist items, it can be rendered to a sequence of frames. To do this, select Render to Frame Sequence... from the Playlist menu. This will open the Render configuration window. Note that this window is modal, which means that the rest of Uniview Theater is inaccessible while this window is open. There are two sub-sections in the configuration window.

**OUTPUT SECTION**

In the Output section, you can configure how many Channels you want to render. This means how many images you want to have for each frame in a sequence or flight path. Normally, you want to render one channel, but in cases with a multi-projector dome you may want to render as many channels as you have projectors in the dome. In the Filename section, you specify the filename of the output frames. The resulting filename will be padded with zeros followed by the frame number and channel number. The Frames section can be used to specify if we want to render only a part of a sequence.

**CHANNEL SETTINGS**

In the Channel Settings section, we configure the settings for each channel. When we render only one channel, there is no need to specify what channel we want to configure, but in multi-channel rendering the below procedure must be repeated for each channel.

**RENDER MODE**

The Render Mode can be one of three – Normal, Omnimap or Stereo Pairs. Normal is a plain image, whereas Omnimap is a fisheye distorted view following the Dome Original standard (i.e. 360x180 degrees field of view). Omnimap mode is rendered through the Omnimap SDK, courtesy of The Elumenati LLC. Stereo pair mode is a stereoscopic image, with one image being rendered for the left eye and one image being rendered for the right eye.

**RESOLUTION**

We can configure output resolution to an arbitrary size, however not larger than what is supported by the graphics hardware on the rendering computer. Normally, on computers with modern graphics cards, this is 4k x 4k pixels. In addition to specifying a custom resolution, we can choose from the preset options.

**FIELD OF VIEW**

Field of Views can be specified either in a simple way, specifying only Horizontal and Vertical field of view, or in an Advanced way specifying both up, down, left and right fields of view. Note that if we have selected Omnimap render mode, the Field of View section is disabled as Omnimap renderings are always 360x180 degrees.
The orientation is used primarily when rendering multi-channel frames. The orientation defines how the Uniview virtual camera should be oriented, and should correspond to the setup of the projectors in for example a dome.

Start the rendering by clicking the Render button. Once started, the Uniview Theater window will change to display what is being written to file for any single frame. In some cases, primarily when using the Omnimap render mode, what is shown on-screen may vary from what is being rendered to file. In the lower left corner of the Uniview Theater window, we can see a counter showing how our render is progressing. You can always abort a rendering by pressing the Abort Rendering button, located in the Playlist Control tool.
ADVANCED COMMANDS

The Command Console is enabled through the Windows->Tools->Command Console menu, or by clicking its button in the Main Toolbar.

THE COMMAND CONSOLE TOOL

The Command Console lets you control advanced features of Uniview Theater. It will allow you to send commands either to specific loaded objects or to core Uniview Theater functionality. For more information on syntax and use of commands, please refer to the run-time command syntax documentation. This tool window also offers a small history display where you can review previously sent commands. To send a command, activate the text field by clicking inside it. Type the command and then either click the Send button or simply press ENTER on the keyboard. While the text field is active, it is possible to scroll through previously sent commands by pressing the up and down arrows on the keyboard.

If you want to send a command to a specific object, make sure that it is selected in the Object Tree tool window and then press “.” in the command console text field. The uniquely identifiable object name, which you have to use to reference the object, will then be automatically inserted in the console text field.
CUSTOMIZING THE GUI

Learn how to create your own buttons to trigger actions that you tend to use frequently. The Custom Events tool is enabled through the Windows->Tools->Custom Events menu, or by clicking its button in the Main Toolbar.

CUSTOM EVENTS TOOL

The custom events tool allows you to create buttons that trigger custom actions. To add a new button, right-click on the button <Unassigned> and select Configure in the context menu. A new window will open where you can edit the behavior of the button.

- The Button Label field lets you specify the text that should appear on the button.
- In the big field below, type in one or several commands that should be triggered by the button. If you’re entering several commands, make sure that they are separated by either a semi-colon or a line break between each of the commands. Refer to the run-time command syntax documentation for information about available commands in Uniview Theater.
- Optionally, you may specify an accelerator key for the button. This will let you launch the commands directly from the keyboard.
- Press OK to create the new button.

To edit the properties of an existing button, right-click on the button and select Configure. To remove an existing button, right-click on the button and select Remove.
# KEYBOARD SHORTCUTS

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Switch to Orbit Mode</td>
</tr>
<tr>
<td>F2</td>
<td>Switch to Free-flight Mode</td>
</tr>
<tr>
<td>F5</td>
<td>Lock to Current Target</td>
</tr>
<tr>
<td>F6</td>
<td>Lock to Sun</td>
</tr>
<tr>
<td>F7</td>
<td>Lock to Stars (Release Lock)</td>
</tr>
<tr>
<td>F9</td>
<td>Show/Hide Tool Windows</td>
</tr>
<tr>
<td>F11</td>
<td>Toggle Full Screen Mode</td>
</tr>
<tr>
<td>f</td>
<td>Toggle Rotational Friction</td>
</tr>
<tr>
<td>F</td>
<td>Toggle Translational Friction</td>
</tr>
<tr>
<td>CTRL</td>
<td>Enable Camera Angle Adjust (keep CTRL and left mouse button pressed and drag the mouse)</td>
</tr>
<tr>
<td>HOME</td>
<td>Jump to Earth</td>
</tr>
<tr>
<td>SHIFT+HOME</td>
<td>Fly to Earth</td>
</tr>
<tr>
<td>t</td>
<td>While dragging the time jog shuttle, press “t” to set the simulation speed to the current value</td>
</tr>
<tr>
<td>.</td>
<td>Press “.” in the command console to insert the name of the currently selected object in the Object Tree tool window.</td>
</tr>
</tbody>
</table>
UNIVIEW CONFIGURATION FILES

This is a brief overview of the Uniview configuration files and the file structure. For information on the specific data formats of Uniview, please see separate documentation.

**CONFIGURATION FILES**

Users should only ever edit the files listed below, except when authoring new data modules. All other files could be modified by the system and should not be manually edited by the user.

**UNIVIEW/CONFIG/UNIVIEW.INI**

This file contains all the settings that control the cluster environment of Uniview, the view frustums of each node in the cluster and system-wide settings. Uniview.ini is replicated across all nodes in a cluster.

**UNIVIEW/CONFIG/SETTINGS.INI**

This file contains settings that affect the control over Uniview from input devices other than a mouse and keyboard, as well as control over label rendering. In short, this file is the configuration file equivalent of the windows->File->Settings... menu in the graphical user interface.

**UNIVIEW/CONFIG/TEXT.CONF**

This file contains settings for what fonts are used when rendering text in Uniview.

**UNIVIEW/CONFIG/FREELOOKCAM.CONF**

This file contains desired velocity values for the free flight camera in different data modules. If users experience the camera is moving too slow or fast when close to certain objects, this file can be edited.

**UNIVIEW/DATA/LOADERSCREEN/LOADERSCREEN.CONF**

This file controls what textures are used for the image-cycle during load time of Uniview.

**UNIVIEW/DATA/MENU/MENU.MU**

For users who find the old on-screen menu useful, this file can be modified to change the appearance of the menu.